RE N ESAS Application Note

Renesas RA Family
GUIX "Hello World" for EK-RA8D1

Introduction

This application note describes the process of creating a simple two-screen GUI using Azure RTOS GUIX
Studio for the EK-RA8D1 kit. This application demonstrates how easily a user can create and configure a
new application using the Renesas Flexible Software Package (FSP).

The Renesas Flexible Software Package includes Azure RTOS ThreadX® real-time operating system, the
Azure RTOS GUIX library and hardware drivers unified under a single robust software package. This
powerful suite of tools provides a comprehensive integrated framework for rapid development of complex
embedded applications.

The Hello World application was developed under e? studio using the Renesas Flexible Software Package.

Required Resources

Development tools and software

e e?studio IDE Version: 2023-10 (23.10.0)

e Renesas Flexible Software Package (FSP) v5.1.0
e Azure RTOS GUIX Studio V6.2.1.0

Hardware
e Renesas EK-RA8D1 kit (RA8D1 MCU Group)
— ER-TFT043-3 with Capacitive Touch Panel 40 pins connection.
— Recommended user should use RA6M3G kit's LCD.
o Renesas EK-RA8D1’s “SW1” switches setting.
— Switch #6 for GLCDC set “ON” and switch #7 for SDRAM set “ON”.
e Renesas-app-lcd-conv_v1_b_mfg order from the link: https://oshpark.com/shared projects/pzfpOmCD
— User needs to click to “Actions” button to order LCD converter board.
— Refer to section “3”. Step 11 on Figure: 29 for pins connection.

Reference Manuals

e RAFlexible Software Package Documentation Release v5.1.0
e Azure RTOS GUIX and GUIX Studio v6.2.1.0

e Renesas RA8D1 Group User’'s Manual Rev.1.1.0

o EK-RA8D1-v1.0 Schematics

Provided Software Files
e AsSource.zip folder that has a touch ft5x06 folderand 4 *.c files inside.
e hal entry.c,system thread entry.c, touch thread entry.c,windows handler.c

Purpose
This document will guide you through the setup of an Azure RTOS GUIX touch screen interface Hello World
application in e2 studio. This document will show how to configure the drivers and library included with the
FSP. These will allow you to set up the GLCD Controller, the touch screen driver, and semaphores to
communicate with application tasks. It also shows the steps necessary to create a simple GUI interface using
the Azure RTOS GUIX Studio editor. In addition, this app note will also cover project setup along with basic
debugging operations. When it is running, the application will respond to touchscreen actions, presenting a
basic graphical user interface (GUI).

Intended Audience
The intended audience is users who want to design GUI applications.
Note: If the user wants to skip fully design and running the fully functional project see Chapter or Section 6.
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1. Downloading and Installing Tools

1.1 Overview

In this section you will copy materials to your PC and install v2023-10.0 /FSP v5.1.0 and Azure RTOS GUIX
studio v6.2.1.0.

1.2 Procedural Steps

1. If you already have e? studio v2023-10 with FSP v5.1.0 or later installed, you can skip this step.
Otherwise, you can download it from https://www.renesas.com/us/en/software-tool/flexible-software-

package-fsp

Detailed installation instructions for the e2 studio and the FSP are available on the Renesas website
https://www.renesas.com/fsp. Review the release notes for ez studio to ensure that the e2 studio version
supports the selected FSP version. The starting version of the installer includes all features of the RA
MCUs.

2. You can get Azure RTOS GUIX Studio v6.2.1.0 or greater from this link.

You should see the window in the next step on the web browser.
Note: Microsoft Store must be installed and working on your PC to install Azure RTOS GUIX studio.
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3. Click Install button and a new window pops up. Click Open Microsoft Store.

B Azure RTOS GUIX Studio - Mic x + N E "

“ c @ apps.microsoftcom ail/azure-rios-guix-st 9PEM1K1RTOQOF Iric=1&activetal vot®%3Aoverviewtabf&hl=en-usBigl=us = ¥ m % O & @

] 1 < ! t @R T E-x allery 10T Systems - Home @™ Group Mesating ™ Renesas Create Raj " Al Baokmark
= Microsoft | Store Home Apps Games Mavies & TV L S Ipp movii @ Open Store app

Azure RTOS GUIX Studio

Microsoft Corporation

50% 2ratings Developer tools

Install 7

Figure 1. Get Azure RTOS GUIX Studio

4. Click Open Microsoft store to continue installing Azure RTOS GUIX studio.

Open Microsoft Store?

https://apps.microsoft.com wants to open this application.

[0 Always allow apps.microsoft.com to open links of this type in the associated app

Open Microsoft Store |

Figure 2. Open Microsoft Store

5. Click “Open” to open “Azure RTOS GUIX Studio” App.

a Microsoft Store

Azure RTOS GUIX Studio

Microsoft Corporation

50 W (@ Privacy &terms (@ More details

€] o
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WG| Azure RTOS GUIX Studio 6.3.0.0 O X
Project Edit Insert Configure Help
B & B X & 0 B &8 F L ¢ & 2 K g G oQ@&@ Mk X @

i Project View -
B No Project

EE Properties View -

Figure 3. Click Open to start “Azure RTOS GUIX Studio”
2. Creating Application Project and Enabled Backlight
2.1 Overview

In this section, you will create a project to which you will add pre-written source code and integrate it with a
pre-created Azure RTOS GUIX studio project.

2.2 Procedural Steps
1. Create a new Renesas RA C/C++ project. Name it ra8d1_guix_hello_world.

B8} Renesas RA C/C++ Project m] X

Renesas RA C/C++ Project

Project Mame and Location

Project name
|| ra8d1_guix_hello_world l

[ Use default location

default

You can download more Renesas packs here

_, < Back Einish Cancel

Figure 4. Create New Project
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2. Select and set board to EK-RA8D1.

) Renesas RA C/C++ Project O X

Renesas RA C/C++ Project —

Device and Tools Selection

Device Selection

Board Description

FSP Version: 5.1.0 i
g Evaluation kit for RABD1 MCU Group
Board: EK-RABD1 i
Visit TBD to get kit user’'s manual, quick start guide, errata, design package,
Device: R7FA8D1BHECBD example projects, etc.
Core: CM85

language: (@ C () C++

Device Details

TrustZone Yes
Pins 224
Processor Cortex-M85
Toolchains Debugger
GNU ARM Embedded J-Link ARM ~

LLVM Embedded Toolchain for Arm

12.2.1.arm-12-mpacbti-34 v

? < Back Einish Cancel

Figure 5. Select and Set Board to EK-RA8D1
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3. Select Flat (Non-TrustZone) and Executable with Azure RTOS ThreadX (v6.2.1+FSP.5.1.0).

BB Renesas RA C/C++ Project O *

Renesas RA C/C++ Project —

Project Type Selection

Project Type Selection

(®) Flat (Non-TrustZone) Project
* Renesas RA device project without TrustZone separation
All code, data and peripheral settings will be configured in this project
Renesas RA device will remain in secure mode
EDMAC RAM buffers will automatically be placed in non-secure RAM

() TrustZone Secure Project
* Renesas RA device project for TrustZone secure execution
* Al code, data and peripherals placed in this project will be initialized as
secure
& Secure project settings such as TrustZone partitions, linker maps and a
list of secure peripherals will be passed to a selected non-secure project
& After initialization, a call to the non-secure startup handler will be made

() TrustZone Mon-secure Project
* Renesas RA device project for TrustZone non-secure execution
* All code, data and peripherals placed in this project will be initialized as
non=-5ecurg
* Must be assodated with a secure project or smart bundle
* Non-secure startup handler will be called after secure code initialization

© o Caree

B Flenecas FA C/Cs + Project o o |

Renesas RA C/C++ Project —
Build Artifact and RTOS Selection |

Busild Astifact Selection RIDS Sebecticn
® Executable Azure RIOS TheeadX (v6.2.1+5sp5.1.00 e
® [Froject builds to an executable file

Static Library
® Progect builds to a static liboary file

| Emecutable Using an RA Static Library
® Progect builds to an executabie file
® Progect uses an existing FLA static libeary project

Figure 6. Select Azure RTOS ThreadX
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4. Use FreeRTOS - Minimal template.

G Renesas RA C/C+ + Project

Renesas RA C/C++ Project

Project Template Seleclion|

Project Template Selection

0

& (3. Azure RTOS ThreadX - Blinky

[Renesas.RA.5.1.0.pack]

Azure RTOS ThreadX project that includes BSP and will blink LEDs if available. This project will initialize the MCU using the BSP. ThreadX will also
be initialized and a single thread to blink the LEDs will be started.

® Q‘ Azure RTOS ThreadX - Minimal

[Renesas.RA.5.1.0.pack]

Empty ThreadX FSP project with no threads. This project will initialize the MCU using the BSP.

Code Generation Settings
[+] Use Renesas Code Formatter

? ) < Back Next > Einish Cancel
Figure 7. Select Azure RTOS ThreadX Minimal Finish
5. Open the project configuration and go to the BSP tab. Change Heap size (bytes) to 0x2000.
£ *IraBd1_guix_hello_world] FSP Configuration = O || Properties e R § =0
i EK-RABD1
Board Support Package Configuration GemeTaa Foject Comant
B Property Value "
£ Restore Defaults || SCHing= e ;
~ RA8D1 Family
Device Selection Secuty
- Board Details OFS0 register settings
FSPversion: |5 L0 - e OFS1 SEL register settings
Evaluation kit for RABD1 MCU Group
Board: EK-RABD1 B3 OFS1 register settings
Visit TBD to get kit user's manual, quick start guide, OFS2 register settings
Device: R7FABD1BHECBD errata, design package, example projects, etc. Block Protection Settings (BPS)
Core: CMmas Permanent Block Protection Settings (PBPS)
= First Stage Bootloader (FSBL)
RTOS: Azure RTOS ThreadX
Clacks
Cache settings
Dual Bank Mode Disabled
Main Oscillator Wait Time 8163 cydes
~ RA Common
Main stack size (bytes) 0x400
Heap size (bytes) 02000 |
MCU Vee (mv) 3300
Parameter checking Disabled

Summary BSP Clocks Pins Interrupts| Event Links| Stacks Components

Assert Failures

Error Log

Clock Registers not Reset Values cluring Startup
Main Oscillator Populated

PFS Protect

C Runtime Initialization

Early BSP Initialization

Main Oscillator Clock Source

Subdock Populated

Subclock Drive (Drive capacitance availability varies by MCU)
Subclock Stabilization Time (ms)

Return FSP_ERR_ASSERTION
No Eror Log

Disabled

Populated

Enabled

Enabled

Disabled

Crystal or Resonator
Populated
Standard/Normal mode
1000

Figure 8. Change Heap Size
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6. Click tab “Clocks” and set “Clocks” for the LCD.

4% *[ra8d1_guix_hello_world] FSP Configuration X | ¢ startupe  [d mainc =@
Clocks Configuration Generate Project Content
[ Restore Defaults
XTAL 20MHz ¢* Clock Src: PLL1P ¥ =y CPUCLK Div /1 ~ = CPUCLK 480MHz &
PLL Src: XTAL b [ ICLK Div /2 ~ —>/ICLK 240MHz
HOCO 48MHz ~ 4 PLDWA ~| > PLLIP Div/2 ~ —>PLLIP 480MHz B > PCLKA Div /4 ¥ —> PCLKA 120MHz
LOCO 22768Hz PLL Mul x48.00 >| > pu1apiv/z ~ —> PLL1Q 480MHz ~ 1> PCLKE Div /8 ~ —> PCLKB 60MHz
MOCO 8MHz PLL 960MHz PLLIR Div /2 ~ —> PLL1R 480MHz 1> PCLKC Div /8 v —> PCLKC 60MHz
SUBCLK 32768Hz L"PLLQ Src: XTAL ~ [>PCLKD Div /4 ~ —>PCLKD 120MHz
PLL2 Div /1 = PLL2P Div /6 ¥ —>PLL2P 200MHz [ PCLKE Div /2 ~ —>PCLKE 240MHz
PLL2 Mul x60.00 > PLL2Q Div /3 ¥ —>PLL2Q 400MHz SDCLK Enabled ~ —>5DCLK 120MHz
PLL2 1.200GHz PLL2R Div /3 ~ —>PLL2R 400MHz [>BCLK Div /4 ~ —>BCLK 120MHz
EBCLK Div /2 ¥ —> EBCLK 60MHz
> FCLK Div /8 ¥ —> FCLK 60MHz
CLKQUT Disabled v —>CLKOUT Div /1 ~ = CLKOUT OHz
SCICLK Disabled  —>5CICLK Div /8 ~ —>|5CICLK OHz
SPICLK Disabled ~ —>5PICLK Div /4 ~ —>|SPICLK OHz
CANFDCLK Disabled ~ —> CANFDCLK Div /8 v —> CANFDCLK OHz
™ LCDCLK Src PLL1O ~ —>LCDCLK Div /5 ¥ —> LCDCLK 96MHz
13CCLK Disabled ~ —>13CCIK Div /3 ¥ —>|I3CCLK OHz
UCK Disabled ~ —>UCK Div /5 ¥ —> UCK OHz
UG0CK Disabled ~ —> UBOCK Div /5 ¥ —> UG0CK OHz
OCTASPICLK Disabled ~ —> OCTASPICLK Div /4 ~ —> OCTASPICLK 0Hz v
Summary BSP Clocks Pins Interrupts| Event Links Stacks Components

Figure 9. Setting All Clocks

7. Add a new thread and name it as System Thread with the settings below.

%% *[ra8d1_guix_hello_world] FSP Configuration = 8 | [ properties
5 0 S
stem Thread
Stacks Conﬁguratlon Generate Project Content Y
Settings Property Value
Threads I'? New Threadlu | Remove = % | New Stack > v Common
System Thread Stacks

General

HAL/Commen Z

. 5 = Timer

% g_ioport I/O Port (r_ioport) Add stacks to the selected thread by using the ‘New Stack’ Taee

4% Azure RTOS ThreadX Port (rm_threadx_port) LY toolbar button (above), or by pasting here from the e r———

& System Thread dlipboard. RA
Interrupts
v Thread
=
Symbol system_thread
Name System Thread
Stack size (bytes) 1024
Priority 5
Auto start Enabled
Time slicing interval (ticks) 5
Objects % | New Object >
Summary BSP | Clocks | Pins | Interrupts | Event Links Components

Figure 10. Add System Thread
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8. Click “New Stack” and add Azure RTOS GUIX to System thread.

95 *[ra8d1_guix_hello_world] FSP Configuration X

Stacks Configuration

Threads % | New Thread % | Remove = 4 | New Stack >
System Thread Stacks

v .J HAL/Common
& g_ioport I/O Port (r_ioport)
4% Azure RTOS ThreadX Port (rm_threadx_port)
& System Thread

Y

‘0-‘ Add stacks to the selected thre

¥ toolbar button (above), or by
clipboard.

= 8 ||B Properties X

O

Generate Project Content

System Thread

Settings Property

Objects % | New Object >

v Common
Analog 2 General
Artificial Intelligence > Timer
Audio > Trace
Bootloader > Performance
Connectivity > RA
DSP N Interrupts
| Graphics > 4 Azure RTOS GUIX |
Input > | P Capture Engine Unit (r_ceu)
Monitoring > @ D/AVE 2D (r_drw)
Motor > @ D/AVE 2D Port Interface (r_drw)
Networking s @ Graphics LCD (r_glcdc)
Power > Time slicing interval (ti
Security >
Sensor >
Storage >
System >
Timers >
Transfer >
¥ Search...

Figure 11. Add Azure RTOS GUIX
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9. Settings properties for Azure RTOS GUIX

Summary BSP Clocks Pins Interrupts Event links Stacks Components

T “{rabd1_guix_hello_world] FSP Configuration < = B | T Properties X
Stacks Confi i Azure RTOS GUIX
= gumEios Generate Project Content
- - - - = Settings Property Value
Threads % MNewThread W Remove ~  Azure RTOS GUIX Stacks & | New Stack > == [«- ® | Remove v Common
v & HAL/Common ~ Hardware Acceleration
& VO Portd " IPEG Codec Support Disabled
g joport A DRW Engine Support Enabled
4 Azure RTOS ThreadX Port (rm_threack_port) Max DRW Operations -
v @ System Thread ~ Internal Thread
# Agure RTOS GUIX ry Stack Size 4096
= = Priority 30
& Azure RTOS GUIX Port (rm_guix_port) Time Slice 10
System Timer (ms) 20
Multithread Support Enabled
@ UTF8 Support Enabled
T - . Event Queue Size 3
4 g_display0 Graphics LCD | | 4% D/AVE 2D Port Interface Enable GX_WIDGET User Data  Disabled
(r_glede) {r_drw)
© @
Y ry
1 1
& Add MIPI DSI Qutput 4 psave 20 (r_drw)
" (Optional)
Objects 9] New Object > % | @
_—_—m ———————
% [ra801_guix_hello_world] FSP Configuration X = B || Properties <
i Azure RTOS GUIX Port (rm_guix
Stacks Configuration e Pl Gt (rm_guix_port)
= = = * . Settings Popety howcied
Threads 4 MewThread # Remove —  System Thread Stacks % | New Stack > == ©xtond Slack > %] Remove ~ Common
APl Info
DRW Buffer Cache Enabled
~ & HAL/Common
& Arure RTOS GUIX w Module Azure RTOS GUIX Port (rm_guix_port)
4 g_ioport I/O Port (r_ioport) i i
& v Display Rotation
Azure RTOS ThreadX Port (rm_threadx_port) CHera Crisabation N
v @ System Thread @ Use Canvas Buffer Disabled
% Azure RTOS GUIX a Canvas Buffer Memory Section
w JPEG Decoding
Work Buffer Size 0xCBOO
Buffer Memory Section bss
MName g_rm_guix_port0
Target Display Layer Graphics Layer 1
T £ T Callback Function MNULL
& g_display0 Graphics LCD 47 D/AVE 20 Port Interface
(r_ghede) (r_drw)
o < 9} ®
Objects %] New Object > ® | “eimove = -
1 1
% Add MIPI DSI Output & DJAVE 20 (r_drw)
(Optional)
®

Figure 12. Setting and Checking Properties for Hardware
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10. Settings property for Graphics LCD

Note: Setting properties for the LCD.

25 *[raBd1_guix_hello_world] FSP Configuration >

Stacks Configuration

Threads % New Thread % | Remove

g startup.c

¥ l-: HAL/Common

4 g_ioport 1/O Port (r_ioport)

4 Azure RTOS ThreadX Port (rm_threadx_port)
~ i@ System Thread

4% Azure RTOS GUIX

Objects 4] New Object >

RA FSP

L€| main.c

Azure RTOS GUIX Stacks

= fa

Generate Project Content

% | New Stack > % .| Remove

4 Azure RTOS GUIX

@

ry

@

4 Azure RTOS GUIX Port (rm_guix_port)

(r_gledc)
©)

” g_display0 Graphics LCD

4% D/AVE 2D Port Interface
(r_drw)

@

%° Add MIPI DSI Output
(Optional)

4% D/AVE 2D (r.drw)

@

Summary BSP Clocks | Pins  Interrupts | Event Links | Stacks | Components

& roblems onsole % Smart Browser ~- Smart Manual
122 Probl 2 console X | @ Smart B ! Smart Manual

71 Properties > | §& Outline

¢ _display Graphics LCD (r_gledc)

Settings  Property Value
v Common
hblity Parameter Checking Default (BSP)
Color Correction Off
~ Module g_display Graphics LCD (r_glcdc)
~ General
Name g_display I
Interrupts
~ Input
~ Graphics Layer 1
~ General
Enabled Yes
Horizontal size 480
1 Vertical size 272 |
Horizontal position o
Vertical position 0
| Color format RG8388 (32-bit) |
Line descending mode Disabled
Background Color
Framebuffer
Line Repeat
Fading
~ Graphics Layer 2
v General
Enabled No
Horizontal size 480
1 Vertical size 272 |
Harizontal position 0
Vertical position 0
1 Color format RGE88E (32-bit) |
Line descending mode Disabled
Background Color
Framebuffer
Line Repeat
Fading
~ Output
¥ Timing
Horizontal total cycles 559
Horizontal active video cycles 480
Horizontal back porch cycles 5
Horizontal sync signal cycles 4
Horizontal sync signal polarit Low active
Vertical total lines 316
Vertical active video lines 272
Vertical back porch lines 8
Vertical sync signal lines 1
Vertical sync signal polarity Low active
Data Enable Signal Polarity High active
Sync edge Rising edge
Format
Background
all})
TCON
Color Correction
> Dithering

Figure 13.

Setting Properties for Graphic LCD
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11. Click “New Stack” and add PWM Timer.

i

ra8d1_guix_hello_world] FSP Configuration X

Stacks Configuration

Threads

% | New Thread % |Remove —

v g?* HAL/Common

Objects

Azure RTOS GUIX

& g_ioport I/O Port (r_ioport)
4 Azure RTOS ThreadX Port (rm_threadx_port)

% | New Object >

= 8 [ properties X

0 System Thread

Generate Project Content

Property
v Common

Settings

General
Timer
Trace
Performance
RA
Interrupts
v Thread
Symbol
Name
Stack size (bytes)
Priority
Auto start
Time slicing interval (ticks)

Port Output Enable for GPT (r_poeg)
Realtime Clock (r_rtc)
Three-Phase PWM (r_gpt_three_phase)

Timer, General PWM (r_gpt)

System Thread Stacks
Analog »
@ Azure RTOS GUIX Artificial Intelligence >
Audio >
Bootloader >
@ Connectivity >
T DSP >
4 Azure RTOS GUIX Port (rm_guix_port) Graphics >
Input >
Monitoring >
@ Motor >
T - Networking >
4 g_display0 Graphics LCD # D/A Power >
(r_gledc) (r_di Security >
Sensor >
® ® Storage >
? System >
%7 Add MIPI DSI Qutput 4 p/A]  Timers > | &
(Optional) Transfer > B
¥ Search... k4
@ I [
' 2
%

Timer, Low-Power (r_agt)

Timer, Ultra-Low-Power (r_ulpt)

Figure 14. Add the Timer

12. Setting “Timer” module properties. Click “arrow” . to set pin P404 for “DISP_BLEN".

Stacks Configuration

Threads

% | New Thread ®_ Remove —

& *[raBd1_guix_hello_world] FSP Configuration

~ m¢ HAL/Common

~ {§ System Thread
4 Azure RTOS GUIX

47 g ioport IO Port (r ioport)
4 Azure RTOS ThreadX Port (rm_threadx_port)

= B | [ Properties >

g_timer_ PWM Timer, General PWM (r_gpt)

Generate Project Content

g_timer_PWM Timer, General PWM ¢ New Stack >
(r_gpt) Stacks

er PWM Timer, General PWM (r_gpt] |

4 g timer PWM Timer,
General PWM (r_gpt)

@

Objects.

%] New Object >

Summary BSP| Clocks | Pins Interrupts Event Links Stacks| Components

Property
¥ Common
Parameter Checking
Pin Output Support
Write Protect Enable

Settings
APl Info

=]
Value

Default (BSP,

Disabled

~ Module g timer PWM Timer, General PWM (r_gpt}

~ General
Name
Channel
Mode
Period
Period Unit
~ Output
Custom Waveform

g_timer_PWM
3

PWM

50000
Nanoseconds

Duty Cycle Percent (only applicable in PWM mode] 50
GTIOCA Output Enabled False

GTIQCA Stop Level

GTIOCB Output Enabled

GTIOCB Stop Level
~ Input
Count Up Source

Count Down Source

Start Source
Stop Source
Clear Source
Capture A Source
Capture B Source

Noise Filter A Sampling Clock Select
Noise Filter B Sampling Clock Select

Interrupts

Extra Features
“ Pins

GTIOC3A

GTIOC3B

Pin Level Low

Pin Level Low

Ne Filter
No Filter

None

Figure 15. Settings Timer Property and DISP_BLEN pin P404
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13. Configuration pin P404 for the DISP_BLEN signal of the LCD panel.

Note:

12.

If the GTIOC3B Pin showed as <unavailable> then user needs to perform step 13 first then step

¢ *[ra8d1_guix_hello_world] FSP Configuration X

Pin Configuration

Select Pin Configuration

| RABD1 EKj v | Manage configurations...

[v] Generate data: | g_bsp_pin_cfg

_ﬂ Export to CSV file & Configure Pin Driver Warnings

G =]
o

Generate Project Content

Pin Selection i [+ =1 l%  Pin Configuration “J Cycle Pin Group
Type filter text Name Value Lock Link

TRGADCIDil " Pin Group Selection Mixed
e Operation Mode [rioca or GTIOCR |

TRG:CAC

- AGT ¥ Input/Output <>

9 'Tfmers'GPT GTIOC3A None
< Timers:
GTIOC3B v PADA )
GPTO 1 | & L= |
GPT1
GPT2
| ¥ GPT3 |
GPT4 < >
GPT5
GPT6 Module name: GPT3
GPT7 v
Pin Function Pin Number
Summary | BSP | Clocks | Pins | Interrupts Event Links | Stacks Components
¢ *[ra8d1_guix_hello_world] FSP Configuration X = |
(¥

Pin Configuration

Select Pin Configuration

| RABD1 EK v

Manage configurations...

[w] Generate data: : g_bsp_pin_cfg |

_ﬁ Export to CSV file E Configure Pin Driver Wamnings

Generate Project Content

Pin Selection = ®m B rin Configuration “J Cyde Pin Group
. Type filter text | Name Value Link
[ Symbolic Name DISP_BLEN
v « P4 ~
h Comment
Ejg? Mode Peripheral mode
E Pull up/down None
'_ ditei IRQ None
; Ejgj Output Type CcMOos
@ Tios Drive Capacity L
Erine v Input/Output e r—
i P404 # GPT3_GTIOC3B =)
7 P408
7 P409 e 2
r:Ra10 Module name: P404 e
i Port Capabilities: CEU: VIO_D3
Y P412 i FTHFR MIl: FTO FXOUT v

Pin Function Pin Number

Summary BSP | Clocks | Pins Interrupts Event Links Stacks  Components

Figure 16. Settings for Pin P404 DISP_BLEN
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Renesas RA Family

GUIX "Hello World" for EK-RA8D1

14. LCD_BLEN pin from the LCD panel will connect to DISP_BLEN pin P404 of the board RA8D1 Figure 17.

VT
Ll ol
T JiE . - LEDA
}iuH
MEPRL 63
::ﬁ[_ ::EQI
e . n_caten s
i iy swil- sl
= ] § =
G A5 pup FB S G
teh BLEN ? | 1 . LEDE
13 T
FO0K F Mokm
—— (Led cwarment 15md)
GND i B
flE.-l L'lﬁf!l
[BACK LIGHT DRIVER]

Figure 17. LCD_BLEN will connect to DISP_BLEN pin P404

15. Refer to “system_thread_entry.c” file in “Source.zip” for more information. This function below controls

the PWM output.

@ * @brief This function is setting up GPT/PWM timer{]

=static fsp_err_t gpt_timer_PWM_setup(void)

{
fsp_err_t err = FSP_SUCCESS;
/* Open GPT */
err = R_GPT_Open(&g_timer_PWM_ctrl, &g_timer_PWM_cfg);
= if(FSP_SUCCESS != err)
{
return err;
1
/* Enable GPT Timer */
err = R_GPT_Enable(&g_timer_PWM_ctrl);
/* Handle error */
= if (FSP_SUCCESS != err)
{
return err;
1
/* Start GPT timer */
err = R_GPT_Start(&g_timer_PWM_ctrl);;
- if(FSP_SUCCESS = err)
{
return err;
}
return err;
1

Figure 18. gpt_timer_PWM
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Renesas RA Family

GUIX "Hello World" for EK-RA8D1

3. Adding and Configuring “Touch Function Driver”

1. Click “New Thread” and name “Touch Thread” with setting below.

95¢ *[raBd1_guix_hello_world] FSP Configuration X

Stacks Configuration

% | New Thread | | Remove —

v .s HAL/Common

& g_ioport I/O Port (r_ioport)

47 Azure RTOS ThreadX Port (rm_threadx_port)
w & System Thread

4 Azure RTOS GUIX

g timer PWM Timer, General PWM (r_gpt)
Touch Thread

Threads

Objects % | New Object >

= O | [ properties %

Touch Thread

Generate Project Content

% | New Stack >
Touch Thread Stacks

0 Add stacks to the selected thread by using the
L¥  'New Stack' toolbar button (above), or by
pasting here from the dlipboard.

Summary | BSP | Clocks | Pins | Interrupts | Event Links Stacks Components

Property
¥ Common

Settings

General
Timer
Trace
Performance
v RA
Hardware Thread Stack Monitoring
Interrupts
~ Thread
Symbol
Name
Stack size (bytes)
Priority
Auto start
Time slicing interval (ticks)

Value

Disabled

touch_thread
Touch Thread
4096

3

Enabled

5

Figure 19. Add and Set TOUCH THREAD Properties
2. Click “New Stack” and add “External IRQ” module.

w5+ *[raBd1_guix_hello_world] FSP Configuration X

Stacks Configuration

Threads

% | New Thread # | Remove =

Touch Thread Stacks

v ::‘ HAL/Common
& g_ioport I/O Port (r_ioport)

v & System Thread
4 Azure RTOS GUIX
&

i Touch Thread

)

= 0|3 Properties X

(V]

Generate Project Content

Properties are not availa

New Stack >

Add stacks to the selected thread by using tl
(above), or by pasting here from the clipboa

4 Azure RTOS ThreadX Port (rm_threadx_port)

imer PWM Timer, General PWM (r_gpt)

Objects % | New Object >

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Analog >
Avrtificial Intelligence b
Audio >
Bootloader >
Connectivity >
DSP >
Graphics >
Input > b External IRQ (Lic) |
Monitoring >
Motor >
Networking >
Power >
Security >
Sensor >
Storage >
System >
Timers >

Figure 20. Add External IRQ
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Renesas RA Family

GUIX "Hello World" for EK-RA8D1

3. Name “g_touch_irq” g_touch_irq and setting External IRQ property.

&% *[ra8d1_guix_hello_world) FSP Configuration X = O || properties X
i touch _irq External IRQ (r_icu)
Stacks conﬁguratlon Generate Project Content - = =
Settings Property Value
Threads % | New Thread | Remove — . % | New Stack > o ¥ Common
o T g_tﬂu:!l_qu Ext:;naf L Parameter Checking Default (BSP)
- e RAUSCStac v Module g_touch_irg External IRQ (r_icu)
@ g_ioport I/O Port (r_ioport) .
< Name g_touch_irg
% Azure RTOS ThreadX Port (1rm_threadx_port) = P 3
v & System Thread % g_touch_irq External IRQ Va S "
- .z (r icu) Trigger Falling
1’ Azure RTOS GUIX Digital Filtering Enabled
@ g_timer_PWM Timer, General PWM (r_gpt) ® Digital Filtering Sample Clock (Only valid | PCLK / 64
v & Touch Thread bk fouchlig et
I'ilg g_touch_irq External IRQ (r_icu) I Pin Interrupt Priority Priority 5
¥ Pins
IRQ3 P510
Objects % | New Object >
Summary BSP Clocks | Pins | Interrupts  Event Links | Stacks  Components <
Figure 21. Setting External IRQ Properties
4. Configuration pin P510 for DISP_INT signal pin.
150 *[ra8d1_guix_hell d] FSP Configuration X = 0
1 *[ra8d1_guix_hello_world] onfiguration

Pin Configuration

Select Pin Configuration

o

Generate Project Content

_;\,.'1 Export to CSV file HConﬁgure Pin Driver Warnings

| RABD1 EM

Pin Selection

Generate data:

Type filter text

v | Manage configurations...

g_bsp_pin_cfg

¢ HMI:CEU
¥ HMI:GLCD

I~ ¢ InterruptiRQ |

IRQ

IRQO
IRQ1
IRQ2

B

IRQ3

<

IRQ4
IRQ5
IRQ6
IRQ7

Pin Function Pin Number

- 1%  Pin Configuration ~J Cycle Pin Group
‘ Name Value Lock
Pin Group Selection Mixed
L)
Operation Mode Custom
¥ Input/Output
IRQ3 ¥ P510 &Y
< >

Module name: IRQ3

Summary BSP  Clocks | Pins Interrupts | Event Links| Stacks Components

Figure 22. Configuration Pin P510 “IRQ3”
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Renesas RA Family GUIX "Hello World" for EK-RA8D1

5. Click “New Stack” and add “I2C Master”.

¢ *[ra8d1_guix_hello_world] FSP Configuration X< = B [ properties X
Stacks Configuration D Touch Thread
Generate Project Content
Settings Property
Threads ¢ | New Thread | Remove |- Touch Thread Stacks = x ¥ Common
1 >
v m HAL/Common & I :n:flog“ i ?:‘::al
" i ifici telli > il
& g_ioport 1/0 Port (r_ioport) o chy i EtamaliRG Sabrolbah ol
= (r_icu) Audio > Trace
% Azure RTOS ThreadX Port (rm_threadx_port) Perf
Bootloader > Reimanee
v @ System Thread @
T T |  connectivity >4 Azure RTOS USBX DFU
& g timer PWM Timer, General PWM (r_gpt) DsP > @ Azure RTOS USBX HCDC
Graphics > @ Azure RTOS USBX HHID
g_touch_irq External IRQ (r_icu) Input > @ Azure RTOS USBX HPRN
Monitoring > @ Azure RTOS USBX HUVC
Matar » @ Azure RTOS USBX OTG CDC
Networking » @ Azure RTOS USBX OTG HID
Powet , @ Azure RTOS USBX PAUD
Security , @ Azure RTOS USBX PCDC
Sanatr N @ Azure RTOS USBX PHID
s SRR R i , @ Azure RTOS USBX PMSC
4 Azure RTOS USBX PPRN
System >
Thriis g 4 CAN FD Lite (r_canfdlite)
4 12C Communication Device (rm_comms_i2c)
Transfer >
@ 12C Master (r iic b_master)
¥ Search. % R =
L _12C Master (r_iic_master)
@ 12C Master (r_sci_b_i2c)
Summary BSP Clocks Pins  Interrupts Event Links Stacks Components 4 12C Shared Bus (rm_comms_i2c)
Figure 23. Add Touch 12C Master
“ H ” .
6. Name “g_i2c_touch” and setting property.
i) *[raBd1_guix_hello_world] FSP Configuration X | L€] touch_ft5x06.c = O || Properties il I
i o i2 i
c_touch 12C Master (r_iic_master]
Stacks Configuration o g_i2c | (r_iic_| )
Settings Property Value
Threads % New Thread ® | Remove — g_i2c_touch 12C Master % | New Stack > D ~ Common
v g HAL/C (r_iic_master) Stacks 0fo Parameter Checking Default (BSP)
= g _Dm::% et Gt DTC on Transmission and Reception Disabled
5 lopol r_lopol e g £
& i; & RTOS Th d)-'( PP it % g_i2c_touch 12C Master (r_iic_master) 10-bit slave addressing Disabled
ure readX Port (rm_threadx_port) v Madule g_i2e_touch 12C Master (r_iic_master)
. B Systam Thréad Name g_i2e_touch
‘b g_timer_PWM Timer, General PWM (r_gpt) @ Channel 1
% Azure RTOS GUIX = Rate Fast-mode
~ @ Touch Thread Rise Time (ns) 120
# g touch irg External IRQ {r icu) &1 Add DTC Driver for &1 Add DTC Driver for Fall Time (ns) 120
I + g_i2c_touch 12C Master (r_iic_master) I Transmission [Optional] Reception [Optionall Duty Cycle (%) 50
Slave Address 0x38
Address Mode 7-Bit
Timeout Mode Short Mode
Objects % | New Object > ® | Remove Timeout during SCL Low Enabled
Callback touch_i2c_callback
® g_touch_semaphore Semaphore Interrupt Priority Level Priority 6
® g_i2c_semaphore Semaphore + Pins
scu P512
SDA1 P511
Summary BSP Clocks Pins | Interrupts EventLlinks Stacks Components

Figure 24. Name and Settings Property
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Renesas RA Family

GUIX "Hello World" for EK-RA8D1

7. Click “New Object” and add Semaphore.

Stacks Configuration

Threads

% | New Thread # | Remove |-

%5 *[ra8d1_guix_hello_world] FSP Configuration X

g_i2c_touch 12C Master

v ;:.“’ HAL/Common

v & System Thread
4 Azure RTOS GUIX

v & Touch Thread

4 g_ioport I/0 Port (r_ioport)
4% Azure RTOS ThreadX Port (rm_threadx_port)
4 g_timer_PWM Timer, General PWM (r_gpt)

& g_touch_irq External IRQ (r_icu)
4 g_i2c_touch 12C Master (r_iic_master)

(r_iic_master) Stacks

O

Generate Project Content

% | New Stack >

==

®

@ g_i2c_touch 12C Master (r_iic_master)

% Add DTC Driver for

Transmission [Optional]

% Add DTC Driver for
Reception [Optional]

Objects

% | New Object >

@ Event Flags

® Mutex
® Queue
| =

Semaphore

<

Summary BSP  Clocks Pins Interrupts Event Links Stacks  Components

Figure 25. Add New Semaphore

8. Name “Touch Semaphore” and setting Property.

i *[ra8d1_guix_hello world] FSP Configuration X

Stacks Configuration

Threads % | New Thread ®.] Remove -

v .2""’ HAL/Common

& g_ioport I/O Port (r_ioport)

4 Azure RTOS ThreadX Port (rm_threadx_port)
v @ System Thread

4% Azure RTOS GUIX

$ g_timer_PWM Timer, General PWM (r_gpt)
v & Touch Thread

& g_touch_irq External IRQ (r_icu)

$ g_i2c_touch 12C Master (r_iic_master)

Objects % | New Object > %_| Remove

@ g_touch_semaphore Semaphorel

=g
V)

Generate Project Content

g_i2¢_touch 12C Master % | New Stack >

(r_iic_master) Stacks

@ g_i2c_touch 12C Master (r_iic_master)

@

I I

% Add DTC Driver for %Y Add DTC Driver for
Transmission [Optional] Reception [Optional]

< >

Summary | BSP | Clocks  Pins | Interrupts | Event Links ' Stacks Components

O Properties X

g new semaphore0 Semaphore

Settings Property Value
Name
Symbol
Initial count 0

Touch Semaphore
g_touch_semaphore

Figure 26. Add and Name Touch Semaphore
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Renesas RA Family GUIX "Hello World" for EK-RA8D1

9. Click “New Object” and add another Semaphore

12¢ *[ra8d1_guix_hello_world] FSP Configuration X =" |m|
; 0
Stacks Conﬁguratlon Generate Project Content
Threads % | New Thread % | Remove — g_i2c_touch 12C Master % | New Stack >
v & HAL/Common (r_iic_master) Stacks
& g_ioport I/O Port (r_ioport) i . o
4 Azure RTOS ThreadX Port (rm_threadx_port) giZc foudtlIE Master [T iicimaster)
~ @ System Thread
4 Azure RTOS GUIX ®
& g_timer_PWM Timer, General PWM (r_gpt) 7Y
v & Touch Thread L .
42 g touch irq External IRQ (r icu) %1 Add DTC Driver for % Add DTC Driver for
$ b Do fotich G Master [ R mosten) Transmission [Optional] Reception [Optional]
Objects % | New Object > ® | Remove
® g_touch semaphore Semaphore ~ ®  Event Flags
® Mutex
® Queue
< ¥
Summary BSP  Clocks Pins Interrupts Event Links Stacks Components

Figure 27. Add Another New Semaphore
10. Name “12C Semaphore” and setting Property.

) *[ra8d1_guix_hello_world] FSP Configuration > =] Properties >
Stacks Configuration ‘ g_new_semaphore0 Semaphore
Generate Project Content
Settings Property Value
Threads % | New Thread ® ] Remove |- g_i2c_touch 12C Master % | New Stack > Name 12C Semaphore
v 2% HAL/Common (r_iic_master) Stacks Sy»rtﬂ:vol g_i2c_semaphore
RE ! Initial count 0
¥ g_ioport I/O Port (r_ioport) — R .
4 Azure RTOS ThreadX Port (rm_threadx_port) 9-2¢ toud aster (r_iic master)
~ & System Thread
@ Azure RTOS GUIX ®
& g_timer_PWM Timer, General PWM (r_gpt) 7Y
v & Touch Thread ! !
& g touch irq External IRQ (r icu) % Add DTC Driver for %1 Add DTC Driver for
e = = Transmission [Optional] Reception [Optional]
“# g_i2c touch 12C Master (r_iic master)
Objects % | New Object > % | Remove
® g touch semaphore Semaphore
I' g_i2c_semaphore Semaphore I
< >
Summary | BSP | Clocks | Pins  Interrupts Event Links | Stacks Components <

Figure 28. Add and Name I12C Semaphore
11. Wiring RA6M3G’s LCD pins connector “NC1” to the pins header “J57” of EK-RA8D1 as shown below.

RAG6M3 LCD Board needs to modify Pins Connector ON RA8D1 Board

Pins# on LCD . Pins # on .

board LCD Pin Name RA8D1 board RA8D1 Pin Name
Connector Connector Connectto | Connector J57

R12ANO132EU0100 Rev.1.00 Page 19 of 56
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Renesas RA Family

GUIX "Hello World" for EK-RA8D1

RA6M3 LCD Board needs to modify

Pins Connector ON RA8D1 Board

EL’:;’; onLCD |} ¢b Pin Name :i:;;?oar 4 | RASD1 Pin Name
o

OPEN 1
2 OPEN 2
3 DE = TCON2 3 > 1 LCDC_TCON2
4 RGB_BO0 4 > 16 LCDC_DATAO00
5 scL 5 > 4 IC_SCL
6 RGB_B1 6 > 15 LCDC_DATAO01
7 RGB_B4 7 > 20 LCDC_DATAO4
8 RGB_B3 8 > 17 LCDC_DATAO03
9 RGB_B5 9 > 19 LCDC_DATAO5
10 RGB_B2 10 > 18 LCDC_DATAO02
11 RGB_B7 1 > 21 LCDC_DATAO7
12 RGB_B6 12 > 22 LCDC_DATAO06
13 RGB_G2 13 > 2% LCDC_DATA10
14 RGB_GO0 14 > 24 LCDC_DATAO08
15 RGB_G4 15 > 28 LCDC_DATA12
16 RGB_G3 16 > 25 LCDC_DATA11
17 RGB_G5 17 > 27 LCDC_DATA13
18 RGB_G1 18 > 23 LCDC_DATA09
19 RGB_G7 19 > 29 LCDC_DATA15
20 RGB_G6 20 > 30 LCDC_DATA14
21 1IC_SDA 21 > 2 IIC_SDA
22 RGB_R1 22 > 31 LCDC_DATA17
23 RGB_R4 23 > 36 LCDC_DATA20
24 RGB_R3 2 > 33 LCDC_DATA19
25 RGB_R5 25 > 35 LCDC_DATA21
26 RGB_R2 26 > 34 LCDC_DATA18
27 RGB_R7 27 > 37 LCDC_DATA23
28 RGB_R6 28 > 38 LCDC_DATA22
29 TCONO = HSYNC | 29 > 9 LCDC_TCONO
30 GND 30 > 39, 40 GND
31 OPEN 31
32 TCON4 =VSYNC 32 > 12 LCDC_TCON1
33 RGB_RO 33 > 32 LCDC_DATA16
34 OPEN 34
35 IC_RST 35 > 6 DISP_RST
36 =+V3.3 36 > 57 =+V3.3
37 RGB_CLK 37 > 10 CLK
38 IIC_INT 38 > 3 DISP_INT
39 LCD_BLEN 39 > 1 DISP_BLEN
40 =+V5.0 40 > 8 =+V5.0

Important note for touch function: User needs to add 10K Ohm resistor to R1 on connection board
(40 pins board connect between LCD and J57 pins connector)
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Renesas RA Family GUIX "Hello World" for EK-RA8D1

5 RGB ENDE
o5 RGB BO

BE b

L,Lg,
7
Biafla o/l =l lal alala il
1= o o ol o P ol G 1 72

DT ¢INIVE A OL

A= o ] £ e o il e ] =1 = ot = e e e =1
ko to
=
@

lefo lote
=

G

b sl o i

TRC T

LY
32 o RGB_VSYNC DNFgR1 T
RGB_RO F10KD 3.3

s
b}
e

e IC_RESET Socket

37 o RGB CIK
38 IC_INT
39 LCD_BLEN

L=}
) 5 P Y

R2
L0ED

a|

I
“

= mu.‘#l

HAAVIH 1d8VdAMT OL

] -

n

Renesas-app-lcd-conv_v1_b_mfg
4 layer board of 1.50 x 2.38 inches (38.1x 60.4 mm)

snulh

Top Bottom
Connects an EK to the EK-RA6M3G LCD board

Figure 29. Schematic and Board Connection between LCD to J57 Connector on EK-RA8D1 Board
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Renesas RA Family GUIX "Hello World" for EK-RA8D1

12. LCD Module pins connection

LCD Module connected as Parallel RGB888 24bits
NC1
il 2 .
3 D
DE = TCON2 ; O & a3 RGB_BO
SCL = O & 3 RGB_B1
RGB B4 5 O & 0 RGB_B3
RGB B5 T 3 O B RGB_B2
RGB B7 3 O & 1; RGB_B8
RGB G2 ll X 6 RGB_GO
RGB G4 l; D O 1S RGB_G3
RGB G5 o O O >0 RGB_G1
RGB G7 51 O O 3> RGB_G6
;‘% O O _)1 RGB_R1
RGB R4 = O & = RGB_R3
GB R5 25 20 RGB_R2
R ' X i
RGB R7 27 28 RGB_R6
29 e 30 i
TCONO = HSYNC gl 0 O %7
= O O —= TCON4 = VSYNC
RGB RO *:‘: 'Y :2 . V33
I %
IC_RST 37 O O 3 g
RGB_CLK 25 o & T 5 &
LCD_BLEN = O O
GND

Figure 30. Set g_i2c_semaphore Semaphore Properties

The pins marked in a black square above are used for the touch panel controller on the LCD board:
— DISP_INT interrupt (P510) is used to trigger touch events.

— 12C channel 1 (P512, P511) is used to read and write data to the touch controller.

— Touch driver folder touch ft5x06 for touch function is inside the provided Source folder.
— PAO1 is used to reset the LCD’s touch controller.
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13. Note: Referto the touch thread entry.c filein Source.zip for more information. The following
code initializes the touch controller and process touch events.

/* Touch Thread entry function */
“void touch_thread_entry(void)
{
GX_EVENT gxe
UINT status
o /*
* Initialize Touch controller:
* FT5Xe6 driver
* IRQ interrupt
*/
ft5x@6_init(&g_i2c_touch, &g_i2c_semaphore, BSP_IO PORT_16 PIN 61);
/* Enable touch IRQ */
R_ICU_ExternalIrgOpen(g_touch_irq.p_ctrl, g_touch_irq.p_cfg);
R_ICU_ExternalIrgEnable(g_touch_irq.p_ctrl);

{e};
8;

= while (1)
{
/* Wait for IRQ from touch controller. */
status = tx_semaphore_get(&g_touch_semaphore, TX_WAIT_FOREVER);
s if(TX_SUCCESS != status)
{

¥

/* Get touch data from the FTSXee */
ft5x06_payload_get(&touch_data);

APP_ERR_TRAP(FSP_ERR_ASSERTION)

& if(eU < touch_data.num_points)

{
/* Send only the TOUCH event of the first finger to the GUIX Model View Controller. */
& if( TOUCH_EVENT_DOWN == touch_data.point[@].event)
{
touch_data.point[@].x;
touch_data.point[@].y;

gxe.gx_event_payload.gx_event_pointdata.gx_point_x
gxe.gx_event_payload.gx_event_pointdata.gx_point_y
gxe.gx_event_type = GX_EVENT_PEN_DOWN;
gx_system_event_send(&gxe);

¥
& else if (TOUCH_EVENT_UP == touch_data.point[@].event && GX_EVENT_PEN_DOWN == gxe.gx_event_type)
{
touch_data.point[@].x;
touch_data.point[@].y;

gxe.gx_event_payload.gx_event_pointdata.gx_point_x
gxe.gx_event_payload.gx_event_pointdata.gx_point_y
gxe.gx_event_type = GX_EVENT_PEN_UP;
gx_system_event_send(&gxe);

A

Figure 31. Initializes the Touch Controller and Process Touch Events
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14. From Stacks Configuration, click “Generate Project Content” to generate project content.

% [ra8d1_guix_hello_world] FSP Configuration > [ERERCING AR &y L)) -G

(¥}
Generate Project Content

Stacks Configuration

Threads < New Thread #!Remove = g_i2c_master0 12C Master (r_iic_master) Stacks | MNew Stack > =% Extend Stack > #|Remove
~ £ HAL/Common

# g_ioport /O Port (r_ioport)
~ @ System Thread

# Azure RTOS GUIX

@ g_i2c_touch 12C Master (r_iic_master)

@
# g_timer_ PWM Timer, General PWM (r_gpt) ; ry ;
> @ Touch Thread % Add DTC Driver for % Add DTC Driver for
# g_touch irq External IRQ (r_icu) Transmission [Optional] Reception [Optional]

# g_i2c_touch 12C Master (r_iic_master)

Objects & Mew Object > #%1Remove

@ g_touch_semaphore Semaphore

® g_i2c_semaphore Semaphore

Summary |BSP |Clocks | Pins | Interrupts Event Links |Stacks| Components

Figure 32. “Generate Project Content”

15. Unzip and open the provided folder Source. zip. Copy the four *.c files and one folder
touch ft5x06 and paste into the folder src of your project “ra8d1_guix_hello_world”.
— Touch_ft5x06 folder
— hal_entry.c
— system_thread_entry.c
— touch_thread_entry.c
— windows_handler.c

0 EK_RA8D1 - ra8d1_guix_hello_world/configuration.xml - ? studio
File Edit Source Refactor Navigate Search Project Renesas Views Run Renesas Al Window Help

- Q - L R4 q -
43 Project Explorer X -5, & T O & ra8d1_guix_hello_world) FSP Configuration X =0
P . D h .
v 1= ra8d1_guix_hello_world [Debug] Stacks Configuration 0
il Indludes Generate Project Content
Bra
(2 ra_gen Threads 4| New Thread # | Remove = g_i2¢_touch 12C Master % | New Stack >
v [P src - IZ‘ HAL/Common (r_iic_master) Stacks

= touch_ft5x06 £ g_ioport I/O Port (r_ioport) & e

c| hal_entry.c 4 Azure RTOS ThreadX Port (rm_threadx_port) GZcitouch RGN stari (i ivastan)

L€l system_thread_entry.c ~ @ System Thread

L€ touch_thread_entry.c 47 Azure RTOS GUIX ®

Le] windows_handler.c & g_timer_PWM Timer, General PWM (r_gpt) 7
(= Debug v i Touch Thread : .
> racfg 49 g touch_irg External IRQ (r_icu) % Add DIC Driver for % Add DTC Driver for
=] script @ g.02c touch 12C Master (r_lic_master) Transmission [Optional] Reception [Optional)
¢ configuration.xml

ra_cfg.txt
¥| ra8d1_guix_hello_world Debug_Flat.launch
(T’) Developer Assistance Objects % | New Object > % | Remove

@ g_touch_semaphore Semaphore
® g_i2c_semaphore Semaphore
Summary BSP | Clocks Pins | Interrupts | Event Links | Stacks Components
Figure 33. Copied Folder and Files
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4. Creating Folders in the Hello_World GUIX_EK_RA8D1 Project for Azure RTOS
GUIX Studio Project

1. Under folder src create a new folder and name it guix gen. Follow the image below, then click Finish.

Fa Project Explorer BEY i 0 & [ra8d1_guix_hello_world] FSP Configuration X | [&l hal |
~ &= ra8d1_guix_hello_world [Debug] Stacks Configuration
il Includes
g ra Threads <| New Thread %! Remove =l
ra_gen
|v & HAL/Common
1 New > I Project.
B < Go Into [T File
- [
[ER Open in New Window Ié Ell(ledfrom Jemplate
older r_gpt
&Det  Showln Alt+Shift+W > 9Py
Erag @ Class
& sc;i - et [i7 Header File
£ | e SRS Source File )
L) 5=l
HON % Delete Delete &8
Brac Cource , Source Folder
% ra8« 4] &1 C/C++ Project
@ Dev v O Example...
Rename... F2
o r t i Other... Ctrl+N  |Remove
21 Import...
& Export. h_semaphore Semaphore
) ) Lemaphore Semaphore
Build Project Ctrl+B
| Refresh F5
Q New Folder O X

Folder ==

Create a new folder resource.

Enter or select the parent folder:

ra8d1_guix_hello_world/src

v & ra8d1_guix_hello_world [Debug]
= settings
= Debug
=ra
= ra_cfg
& ra_gen
= script
& src

Folder name:} guix_gen

Advanced >>

Figure 34. Create and Name “guix_gen” Folder
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2. Under folder src create a new folder and name it guix studio. Then follow the image below and click

Finish.
Proje plore BE®Y § =0 £ [ra8d1_guix_hello_world] FSP Configuration * | [& hal_entry.c 18 tx_cmsis.h
~ & ra8d1_guix_hello_world [Debug] I ‘ i N £t _at_
i Includes New > 9 Project...
Era Go Into [T File
~ .
@ ra_gen e i D |7 File from Template
v @ gc ) 155 Folder I
& aui Show In Alt+Shift+W >
guix_gen @ Class Create a new folder resource
&l hal_entry.c & Copy Cl+C & Header File
¢ system_thread_entry.c Paste Ctrl+V P Samen e
[8 touch_thread_entry.c ® Delete Delete Source Folder
& Debug ;‘“’rce > @ e Project
& ra_cfg oV Convert to a C/C++ Project (Adds C/C++ Nature)
= script Rename... F2
- ) . = Example...
i configuration.xml s Import
- - 9 Other... Ctrl+N
Era cfg.bct. 4 Export. er : i
¥ ra8d1_guix_hello_world Debug_ Renesas FSP Export N F‘
Q New Folder L X
Folder —
Create a new folder resource.
Enter or select the parent folder:
ra8d1_guix_hello_world
o
% ra8d1_guix_hello_world [Debug]
Folder ﬂame:l guix_studio I
Advanced >>
Figure 35. Create New Folder and Name “guix_studio”
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Renesas RA Family GUIX "Hello World" for EK-RA8D1

3. Under folder guix_studio that was created earlier, create a new folder and name GNU. Follow the
image below, then click Finish.

fa Project Explorer BSY § T 0 & [ra8d1_guix_hello_world] FSP Configuration * | & hal_
v & ra8d1_guix_hello_world [Debug] Stacks Conﬁguration
wl Includes
; ra Threads | New Thread %! Remove =
ra_gen
v @8 grc v & HAL/Common
& guix_gen # g_ioport /O Port (r_ioport)
[2 hal_entry.c v @& System Thread

4 Azure RTOS GUIX
% g_timer_PWM Timer, General PWM (r_gpt)
v @& Touch Thread

&= Debug
% g_touch_irg External IRQ (r_icu)

[£ system_thread_entry.c
l¢ touch_thread_entry.c

= ra_cfg New > 7 Project...
& script Go Into 9 File
& configurati % Fi
J Show In Alt+Shift+W > pemaioitom femplate
E ra_cfg.txt 9 Folder
o B Co Ctrl+C
X ragd1_guix = &% Source Folder e
@ Developer Paste Ctrl+V . : |
R Delete Delete C/C++ Project
Move... O Example...
Rename... F2 [ Other. Ctrl+N
Q New Folder [l X
Folder - =
Create a new folder resource.
Enter or select the parent folder:
ra8d1_guix_hello_world/guix_studio
1
= .settings A
= Debug
& guix_studio
&ra
& ra_cfg
£ ra_gen
= script
= src v
Folder ﬂame:l GNU| I

Advanced >>

@ [_gnsh ] conce

Figure 36. Create New Folder and Name “GNU”
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Renesas RA Family GUIX "Hello World" for EK-RA8D1

4. After the sub-folder GNU is created, the folder structure should look like the image below.

Q EK_RA8D1 - ra8d1_guix_hello_world/configuration.xml - e studio

File Edit Source Refactor Navigate Search Project Renesas Views Run Renesas Al Window Help
ﬁ} - Q - fo) ‘t}. - ‘l -

{3 Project Explorer X =

. = 0 ||o [ra8d1_guix_hello_world] FSP Configuration X
v i ra8d1_guix_hello_world [Debug]

Stacks Configuration
il Includes
B ra
8 ra_gen Threads

% | New Thread ® | Remove —

v (2 src

e i:f" HAL/Common

£ g_ioport I/O Port (r_ioport)

4 Azure RTOS ThreadX Port (rm_threadx_port)
v & System Thread

& Azure RTOS GUIX

= guix gen
(= touch_ft5x06
.| hal_entry.c
.£] system_thread_entry.c
.c| touch_thread_entry.c

@ g_timer_ PWM Timer, General PWM (r_gpt)
.£] windows_handler.c

w & Touch Thread
= Debug

+ g_touch_irq External IRQ (r_icu)
@ g_i2c_touch 12C Master (r_iic_master)

v [ guix_studio
(= GNU

= ra_cfg

k= script
12 configuration.xml Objects

% | New Object > ® | Remove
| ra_cfg.txt

@ g_touch hore S h
X ra8d1_guix_hello_world Debug_Flat.launch = g_.ouc e
. s ® g_i2c_semaphore Semaphore
2] Developer Assistance

Figure 37. Project with New Folder
5. Using Azure RTOS GUIX Studio create GUI Windows
1. Open Azure RTOS GUIX Studio v6.2.1.0 or greater.

GUIX Studio

Figure 38. GUIX Studio Icon
2. Create a New Project and name it Hello World.
Select Project. From the drop-down list, select New Project.
Project Name: Hello_World.

Project Path: Browse to the location of the folder you created in the ra8d1_guix_hello_world>
guix_studio\GNU as shown in the image below.

Hit OK button and then the Save button to confirm your selections.

moows»
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Renesas RA Family

GUIX "Hello World" for EK-RA8D1

Project Edit Insert Configure Help

}G{ Azure RTOS GUIX Studio 6.2.1.0 - Hello_World

Close Project

Import Project

Recent Projects
Generate All Output Files
Generate Resource Files

Generate Specification Files

New Project CukN | m =2 B 3 5 g @ m» F @
Open Project Ctrl+O 7
) Create New Project
Save Project Ctrl+S
Save Project As Shift+Ctrl+S

Project Name *‘ Hello_World ‘

Project Path *‘ C:\WorkSpace\Fa8di_guix_hello_world\guix_studio\GNU ‘ Browse...

* Indicates required field

Cancel Save

a EK_RA8D1 - ra8d1_guix_hello_world/configuration.xml - &2 studio

Exit Alt+F4
OO 1 TOpoitoo Vi bl | File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help

# Debug & ra8d1_guix_hello_world [milhg [ B~ &§ v @it i@ R[4

P Project Explorer EE T § = 0% [ra8d1_guix hello_world] FSP Configuration X | hi

v & ra8d1_guix_hello_world [Debug] Stacks Conﬁguration

& Includes
Sra
Threads &I New Thread #IRemove =
& ra_gen
8 src v & HAL/Common
& Debug # g_ioport I/O Port (r_ioport)

& quix studio v & System Thread
4 Azure RTOS GUIX
& racfg @ g_timer_PWM Timer, General PWM (r_gpt)
v & Touch Thread
# g_touch_irq External IRQ (r_icu)
# g_i2c_touch 12C Master (r_iic_master)

<

= script

% configurationxml

[ ra_cfg.txt

[¥ ra8d1_guix_hello_world Debug_Flat.launch

@ Developer Assistance

Figure 39. GUIX Studio Creates Hello World Project

3. A new Configure Project window will pop up and user needs to set all the options as shown in Figure 40.
included Advanced Settings. Finally, click Save.

{3} Configure Project x

« resolution | 480

pixels

Directories "
Source Flles | ..\ \srclgulx_gen el Renesas Graphics Advanced Settil %
Header Flles LA Asrchguix_gen —— e
- | Enable 20 Drawing Engine
Retource Files | .-\ \src\guix_gen Lo
Runtime Image Decoder
Target CPU | Renesas RA w Achancsd Setings
- WPEG: | Saftwane IPEG Decoder St
Toolchain | GHU w _:blq endian
PHG:  Software PNG Decoder ~
Additional Headers | Insert Before
Number of Displays | 1 2 GUIDX Library Version | 6 = [2 2 [0 2
Major Minor  Patch Cancel
Display Configurati
Display Mumber |1 = Name | display

y resolution | 272 | pixels

1 bpp
£ Y
4 bpp
)8 bpp
L )16 bpp
(132 bpp

Cancel

: ] 1:5:5:5 formal

|| 4:4:4:4 format

[ reverse byte order 3:2 format

[Jallocate canvas memaory Rotation:  Wone -

—

Figure 40. Configuration New Project “Hello World” with Advanced Settings
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Renesas RA Family GUIX "Hello World" for EK-RA8D1

4. Star New Project “Hello World” should look similar Figure 41.

JG| Azure RTOS GUIX Studio 6.2.1.0 - Hello_World — O0 X

Project Edit Insert Configure Help
0 & BB ¥ B8 © 8 © b w2 [ 3 G 0 Q& pr F G

1 Project View = E Theme: "theme_1"

[& Hello_World & Colors
=R Ll display
-3 default_folder T Fonts

+-C window [E Pixelmaps

</> Strings

FH Properties View -

Widget Type window

Widget Name window

Widget Id

User Data

Left 0

Top 0

Width 480

Height 272

Border Thin Border =z
Transparent D
Draw Selected D
Enabled
Accepts Focus
Runtime Allocate D
Normal fill WINDOW_FILL =
Selected fill WINDOW_FILL =
Disabled fill DISABLED_FILL i
Template D
Visible At Startup D

Draw Function

Event Function

Wallpaper None e
Tile Wallpaper ]
Figure 41. After Settings New Project “Hello World”
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GUIX "Hello World" for EK-RA8D1

5. Setting Properties View of Window1.

JG{ Azure RTOS GUIX Studio 6.2.1.0 - Hello World

Project Edit Insert Configure Help

‘ f a 3 S E =
rh Project View -
I: Hello World

BQ display

== default_folder

| \Vinclow 1
Ef Properties View _

Widget Type window

Widget Name Window1

Widget Id ID_WINDOW1

User Data

Left 0

Top 0

Width 480

Height 272

Border Mo Border 5
Transparent D
Draw Selected D
Enabled
Accepts Focus
Runtime Allocate D
Normal fill WINDOW_FILL R
Selected fill WINDOW_FILL i
Disabled fill WINDOW_FILL =7
Template i
Visible At Startup []
Draw Function

Event Function window1_screen_event

Wallpaper None 5
Tile Wallpaper D

Figure 42. Property View of Window1
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Renesas RA Family

GUIX "Hello World" for EK-RA8D1
6. To add String ID, click on Strings. Follow the images below.

! Theme: "theme 1"

& Colors

[s] Pixelmaps

<[> Strings

Figure 43. Strings
7. From the Strings dropdown, click + Add New String.

! Theme: "theme_ 1"
& Colors

[&] Pixelmaps

<[> Sirings

String ID

English

4k
'+ Add New String
Figure 44. Add New String
8. New String Table Editor window will pop up. Click the Add String button.
<k Strina Table Editor X
Delete String Import Export = Sorting By: | String ID i
Stringld ~ English <| Widgets that use this string:
STRING_1
# Indicates required field
String 1D: * |STRING_1 Number of references: 0
String Text: Stnng width (pixels): 0
Font: SYSTEM v
Notes:
Cancel Save
Figure 45. String Table Editor
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9. Edit String ID and String Text.

<l> String Table Editor

Add String Delete String Import Export B Sorting By: |String ID b

Stringld ~ English 4| Widgets that use this string:

CHECKBOX_TEXT Press Mel

# Indicates required field

—_—
String ID:  4|CHECKBOX_TEXT | Number of references: 0
String Text: Press Mel String width (pixels): 10

Font: SYSTEM ~

Notes:

Cancel Save

Figure 46. Edit String ID and String Text

10. Continue to click Adding String, then edit String ID and String Text until the table appears like Figure
47 Then click the Save button.

<[> String Table Editor

| Add String { Delete String Import Export I:'ﬂ Sorting By: None ™

Stingld English w 4| Widgets that use this siring:
CHECKBOX_TEXT Press Mel Window1_buttonenabler
INSTRUCT_CHECKBOX Press to activate (blue), "Press me" for more.
BUTTON_DISABLED Stay in window Press Me!
WINDOW1 Window1
HELLO_WORLD Hello World -> Press anywhere to go to window 1
WINDOW2 Window2
BUTTON_ENABLED GoTo Window 2
INSTRUCT_BUTTON Press "Goto window?2" to show the next screen.
* Indicates required field
String ID:  * ‘CHECKB(_}X?TEXT Number of references 1
String Text: Press Mel String width (pixels) 10
Font: SYSTEM ~

Notes:

Cancel Save

Figure 47. All Strings
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11. Right-click on Window1 to insert a Text Button and follow Figure 48.

JG| Azure RTOS GUIX Studio 6.2.1.0 - Hello World
Project Edit Insert Configure Help
: ] B 4 By Ll = = ™ In = Ha = [ [1
[& Hello_World
g display
B-& default_folder
P i_l
Cut
Copy
Paste
Delete
- I Insert > I Folder
Widget Type WG
Widget Name Window1 i .
Widget Id ID_W\NDOVI Sutton . Sutton
User Data Text > Text Button
Left 0 Indicator > Multi Line Text Button
Top 0 Menu > Checkbox
Width 480 Radio Button
Height 272 lcon Button
Border No Border ~ Pixelmap Button
Transparent L Icon
Draw Selected []
Enabled
Accepts Focus
Runtime Allocate []
Normal fill WINDOW_FILL he
Selected fill WINDOW_FILL 53
Disabled fill WINDOW_FILL
Template []
Visible At Startup []
Draw Function
Ewvent Function window1_screen_event
Wallpaper None i
Tile Wallpaper []
Figure 48. Insert Text Button
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12. Set Properties View of “text_button”.

JG| Azure RTOS GUIX Studio 6.2.1.0 - Hello World

Project Edit Insert Configure Help
B & B ¥ 858 © |k & F b &
[& Hello_World
= L display
= default_folder
= Window1

R Properties View —

Widget Type text_button

Widget Name windowchanger

Widget Id ID_WINDOWCHANGER

User Data

Left 22

Top 32

Width 204

Height 50

Border No Border hd
Transparent |:|
Draw Selected []
Enabled
Accepts Focus
Runtime Allocate |:|
Normal fill BTN_LOWER 2
Selected fill BTN_UPPER ™
Disabled fill BTN_LOWER M
Draw Function

Event Function

Pushed |:|
Toggle D
Radio []
Auto Repeat []
String ID None ki
Text

Font PROMPT hd
Text Align Center b
Normal Text Color BTN_TEXT 2
Selected Text Color BTN_TEXT i
Disabled Text Color BTN_TEXT g
Private Text Copy D

Figure 49. Properties View of text_button
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13. Right-click windowchanger to insert a Prompt and follow Figure 50.

'G‘ Azure RTOS GUIX Studio 6.2.1.0 - Hello_World.gxp

Project Edit Insert Configure Help
B & B ¥ B3 B |2 & ™ kb = i 2 B O G O @ w4k T @

L, Project View -

Hello World

= : default_folder
= Window1
o windowchange

Cut
Widget Type fext b Paste
Widget Name windc Delete
[Widgetid D_W Insert > Folder
User Data )
e 2 Window >
op 3 Button >
Width 204 20 i’ Prompt
Height 50 Indicator > Numeric Prompt
Border No Border Menu > Pixelmap Prompt
Transparent ] T MNumeric Pixelmap Prompt
Draw Seleded [] ] Single Line Input
Enabled Multi Line View
Accepts Focus Multi Line Input
Runtime Allocate [] Rich Text View

Figure 50. Insert Prompt
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GUIX "Hello World" for EK-RA8D1

14. Set Properties View

of prompt.

JG| Azure RTOS GUIX Studio 6.2.1.0 - Hello World

Project Edit Insert Configure Help
_ = B X B B R

1 Project View -

[& Hello_Weorld

Bi_l Window1
=@ windowchanger

=R windowchangertext

EH Properties View -

Widget Type prompt

Widget Name windowchangertext

Widget Id ID_WINDOWCHANGER_TEXT

User Data

Left 44

Top 42

Width 160

Height 30

Border No Border ™

Transparent

Draw Selected []

Enabled

Accepts Focus [ ]

Runtime Allocate [ ]

MNormal fill WIDGET_FILL R

Selected fill SELECTED_FILL i

Disabled fill DISABLED_FILL i

Draw Function

Event Function

Sfring ID BUTTON_DISABLED e

Text Stay in window1

Font PROMPT "2

Text Align Center =

MNormal Text Color TEXT ~

Selected Text Color SELECTED_TEXT bl

Disabled Text Color DISABLED _TEXT M

Private Text Copy } |:|
Figure 51. Properties View of Prompt
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15. Insert new Button. Right-click on windowchangertext and follow Figure 50.

IG‘ Azure RTOS GUIX Studio 6.2.1.0 - Hello_World.gxp

Project Edit Insert Configure Help
BB X B 98 Bk AT LI w2 5L &E0 Q@ e F O
Hello World
SR display

B default_folder

Cut
.
Widget Type prompt Py
Widget Name windowchang | o5t
Widget Id ID_WINDOW Delete
User Data I Insert > I Folder
Left 44 Window >
Top 42 Button > Button
Width 160 Text > Text Button
Height 30 Indicator > Multi Line Text Button
Border No Border Menu > Checkbox
Transparent Radio Button
Draw Selected [] lcon Button
Enabled v
Pixelmap Button
Accepts Focus D
: lcon
Runtime Allocate []
Figure 52. Insert Button
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16. Set the Properties view of button.

}G| Azure RTOS GUIX Studio 6.2.1.0 - Hello World.gxp
Project Edit Insert Configure Help
_Eﬁx%ﬁln--nll_ﬂﬂ'%lﬂlﬁ
= & display A
= default_folder
= Window1
=@ windowchanger
= =] windowchangertext

O window1changer -
Widget Type button
Widget Name window1changer
Widget Id ID_WINDOW_1_CHANGER
User Data
Left 22
Top 32
Width 204
Height 50
Border No Border >
Transparent
Draw Selected []
Enabled
Accepts Focus []
Runtime Allocate []
Normal fill BTN_LOWER v
Selected fill BTN_UPPER v
Disabled fill DISABLED_FILL e
Draw Function
Event Function
Pushed []
Toggle []
Radio []
Auto Repeat []

Figure 53. Properties View of Button
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17. Insert Prompt. Right click on Window1 and follow Figure 54. Insert two times to get two prompts.
Prompt and Prompt1 will show up once you finish.

JG| Azure RTOS GUIX Studio 6.2.1.0 - Hello World

Project Edit Insert Configure Help

EE Properties View -

: — o b4 B D =1 = (o Io H
E_l Hello World
=& display
= & default_folder
SRm|\Vindo
=@ wind Cut
=N Copy
b Paste
Delete
Insert > Folder
EH Properties View Rl
Widget Type window Hnien
Widget Name Window1 I Text 4 Prompt
Widget Id ID_WINDOW1 Indicator > Numeric Prompt
User Data Menu > Pixelmap Prompt
Left 0 Numeric Pixelmap Prompt
Top 0 Single Line Input
Width 480 Multi Line View
Height 272 Multi Line Input
Border No Border > Rich Text View
,,,,,,,,,,, [ —
JG| Azure RTOS GUIX Studio 6.2.1.0 - Hello World
Project Edit Insert Configure Help
: ] o b4 s o =8
[ Hello_World
B display
— default folder
5[ Window1
[=] prompt
o — \
=@ windowchanger
=R windowchangertext
- window? changer

Figure 55. Insert Prompts
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18. Set the Properties View of Prompt.

JG| Azure RTOS GUIX Studio 6.2.1.0 - Hello World

Project Edit Insert Configure Help

: = B X B © I
rh Project View -
D_ Hello_ World

EH Properties View -

Widget Type prompt

Widget Name instructions

Widget Id ID_INSTRUCTIONS

User Data

Left 19

Top 120

Width 445

Height 90

Border No Border i
Transparent E
Draw Selected [
Enabled [V
Accepts Focus [V
Runtime Allocate [
MNormal fill WIDGET_FILL b
Selected fill SELECTED_FILL M
Disabled fill WIDGET_FILL M
Draw Function

Event Function

String ID INSTRUCT_CHECKBOX b
Text Press to activate (blue), "Press me" for
Font PROMPT b
Text Align Center 2
MNormal Text Color TEXT 4
Selected Text Color SELECTED_TEXT b
Disabled Text Color TEXT b
Private Text Copy D

Figure 56. Properties View of Prompt
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Renesas RA Family

GUIX "Hello World" for EK-RA8D1

19. Set the Properties View of Prompt1.

JG| Azure RTOS GUIX Studio 6.2.1.0 - Hello World

Project Edit Insert Configure Help
: — B 4 By © =5

m Project View -

D Hello World
BQ display

instructions

| window1_text

- window1 changer

EE Properties View B

Widget Type prompt

Widget Name window1_text

Widget Id ID_WINDOW1_TEXT

User Data

Left 205

Top 237

Width 80

Height 20|

Border No Border =7
Transparent v
Draw Selected []
Enabled [
Accepts Focus IZ
Runtime Allocate []
Normal fill WIDGET_FILL b
Selected fill SELECTED_FILL i
Disabled fill WIDGET_FILL M
Draw Function

Event Function

String ID WINDOWA 2
Text Window1

Font PROMPT i
Text Align Center M
Normal Text Color TEXT »
Selected Text Color SELECTED_TEXT b
Disabled Text Color TEXT »
Private Text Copy |:|

Figure 57. Properties View for Prompt1
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20. Insert button Checkbox. Right click on Window1 and follow Figure 58.

}G| Azure RTOS GUIX Studio 6.2.1.0 - Hello World

Project Edit Insert Configure Help
v 3 Bs & = =l (O I =

r Project View -

Hello World
EIQ display
EIIZI default_folder

Cut

Copy
Paste

Delete

Insert Folder
EE Properties View Window >
Widget Type window Button ? Button
Widget Name Window1 Text b Text Button
Widget Id ID_WINDOW Indicator > Multi Line Text Button
User Data Menu > Checkbox I
Left 0 Radio Button
Top 0 Icon Button
S 480 Pixelmap Button
Height 272 Josrm
Figure 58. Insert Button Checkbox
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GUIX "Hello World" for EK-RA8D1

21. Setting Properties View of Button Checkbox.

JG| Azure RTOS GUIX Studio 6.2.1.0 - Hello World

Project Edit Insert Configure Help

_ I~ o # B i =
[ Hello_ World A
=E=] display
B default_folder
=R {1 Window1
|
instructions

window1_text v
Widget Type checkbox ~
Widget Name buttonenabler
Widget Id ID_BUTTONENABLER
User Data
Left 31
Top 34
Width 160
Height 50
Border MNo Border V
Transparent
Draw Selected []
Enabled
Accepts Focus
Runtime Allocate D
Normal fill BTN_LOWER i
Selected fill BTN_UPPER i
Disabled fill BTN_LOWER R
Draw Function
Event Function
Pushed D
Toggle
Radio L]
Auto Repeat L]
String ID CHECKBOX_TEXT 5
Text Press Me!
Font BUTTON M
Text Align Left R
Normal Text Color BTN_TEXT i
Selected Text Color BTN_TEXT M
Disabled Text Color BTN_TEXT i
Private Text Copy DI
Unchecked Pixelmap CHECKBOX_OFF R
Checked Pixelmap CHECKBOX_ON S
Unchecked Disabled None £

Figure 59. Setting Button Checkbox Properties
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Renesas RA Family

GUIX "Hello World" for EK-RA8D1

22. After you have finished creating Window1, it should be like the image below.

JG{ Azure RTOS GUIX Studio 6.2.1.0 - Hello_World

Project Edit Insert Configure Help
[ 4 7] % B B =

5 Project View -

[ Hello_World
=L display
=113 default_folder
=] Window1
~-{v] buttonenabler

window1_text
E-@ windowchanger
-] windowchangertext
~{Jwindow1changer

EE Properties View

Widget Type window

Widget Name Window1

Widget Id ID_WINDOW1

User Data

Left 0

Top 0

Width 480

Height 272

Border No Border 2
Transparent ]
Draw Selected |
Enabled [
Accepts Focus

Runtime Allocate ]
Normal fill WINDOW_FILL ~
Selected fill WINDOW_FILL =
Disabled fill WINDOW_FILL 2
Template |
Visible At Startup ]
Draw Function

Event Function window1_screen_event

Wallpaper None ™
Tile Wallpaper [l

Window1

[] Press Me!

& Theme: "theme_1"
& Colors

[&&] Pixelmaps

</» Strings

String ID English
BUTTON_DISABLED  Stay in window1
BUTTON_ENABLED  GoTo Window 2
CHECKBOX_TEXT ~ Press Mel

HELLO_WORLD Hello World -> Press anywhere to go to window 1
INSTRUCT_BUTTON Press "Goto window2" to show the next screen.
INSTRUCT_CHECKBQ> Press to activate (blue), "Press me" for more.

WINDOW1 Window1
WINDOW2 Window2
STRING_1 button
STRING_2 prompt
STRING_3 checkbox

L'E Add New String

Figure 60. Window1 Created

23. Insert Window2. Right click on default_folder and Insert > window > window follow Figure 61.

JGl Azure RTOS GUIX Studio 6.2.1.0 - Hello_World
Project Edit Insert Configure Help
- a ¥ B Lv] = = ™ I = L] =
[& Hello_World
=L display
= Edit Folder Properties
Cut
Copy
Paste
Delete
I Insert > Folder
& windowTcnhanger Window > Window
e i Button > Vertical List
Text > Horizontal List
Indicator > Drop-down List
Menu > Line Chart

String Scroll Wheel
Numeric Seroll Wheel
Generic Scroll Wheel

Figure 61. Insert Window2
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24. Setting Properties View of Window?2.

}G| Azure RTOS GUIX Studio 6.2.1.0 - Hello World

Project Edit Insert Configure Help

‘ = B X & B =
m, Project View -
= L display A

instructions

window1_text

) window1 changer

----- Hro] :
EH Properties View E

Widget Type window

Widget Name Window?2

Widget Id ID_WINDOW?2

User Data

Left 0

Top 0

Width 480

Height 272

Border No Border 2

Transparent []

Draw Selected []

Enabled

Accepts Focus

Runtime Allocate []

MNarmal fill WINDOW_FILL b

Selected fill WINDOW_FILL b

Disabled fill WINDOW_FILL R7

Template ]

Visible At Startup []

Draw Function

Event Function window2_screen_event

Wallpaper None e

Tile Wallpaper []
Figure 62. Setting Properties of Window2
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25. Insert Prompt for Window2. Right click from Window2. Insert > Text > Prompt follow Figure 63.

'G‘ Azure RTOS GUIX Studio 6.2.1.0 - Hello World

Project Edit Insert Configure Help

- 7] X Bs B =
rh Project View -

=N L display A

instructions

window1_text

Prompt

..... = 5
Cut

Widget Type Paste
Widget Name Delete
Widget Id
User Data Insert > Folder
Left 0 Window >
Top 0 Button )
Width 480 Text >
Height 272 Indicator >
Border NoBorder Menu >
Transparent
Draw Selected
Enabled

Accepts Focus

Runtime Allocate

Bl Loy

CCRIRIC ]

Numeric Prompt

Pixelmap Prompt
Numeric Pixelmap Prompt
Single Line Input

Multi Line View

Multi Line Input

Rich Text View

Figure 63.

Insert Prompt for Window2
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26. Setting Properties View of Prompt.

}G| Azure RTOS GUIX Studio 6.2.1.0 - Hello World

Project Edit Insert Configure Help

: — ] 3 By D =
m, Project View -
B ------ @ default_folder A

instructions

window1_text

=] Window?2

----- .

EH Properties View E

Widget Type prompt

Widget Name window?2_text

Widget Id ID_WINDOWZ_TEXT

User Data

Left 196

Top 244

Width 80

Height 24

Border No Border 2
Transparent
Draw Selected D
Enabled [
Accepts Focus
Runtime Allocate D
MNarmal fill WIDGET_FILL b
Selected fill SELECTED_FILL ~
Disabled fill WIDGET_FILL b
Draw Function

Event Function

String ID WINDOW?2 w7
Text Window?2

Font PROMPT 7
Text Align Center R
Normal Text Color TEXT i
Selected Text Color SELECTED_TEXT b
Disabled Text Color DISABLED TEXT b
Private Text Copy

Figure 64. Setting Properties of window2_text
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27. Insert text_button for window2. Right click from Window2 > Insert > Button > Text_Button follow
Figure 65.

lG‘ Azure RTOS GUIX Studio 6.2.1.0 - Hello_World

Project Edit Insert Configure Help

= @ ¥ 8 0B = & T L Z
rh Project View :
E|IL‘I default folder A
= ClWindow1
-] buttonenabler

instructions
window1_text

=R windowchangertext

-2 window1changer

=
I winc Cut >
Copy
Widget Type Delete

Widget Name I Insert > I Folder
Widget Id

= ID_VVNDUOUYY L

- Window >

User Data

Button > Button
Left 0

Text b Text Button
Top 0
Widih 480 Indicator > Multi Line Text Button
Height 272 Menu > Checkbox
Border No Border - ‘ Radio Button
Transparent ] Icon Button
Draw Selected [] Pixelmap Button
Enabled lcon

Figure 65. Insert text_button for Window2
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28. Setting Properties View of text button.

JGI Azure RTOS GUIX Studio 6.2.1.0 - Hello World

Project Edit Insert Configure Help
_ ] B 3 By LF! =

 Project View -

=N windowchangertext A
- window1changer
= Window?2

v
Widget Type text_button

Widget Name window2changer

Widget Id ID_WINDOW_2_CHANGER

User Data

Left 3

Top 28

Width 420

Height 212

Border Mo Border i
Transparent D
Draw Selected []
Enabled
Accepts Focus
Runtime Allocate D
Normal fill SELECTED_FILL ™
Selected fill SELECTED_FILL b
Disabled fill BTN_LOWER i
Draw Function

Event Function

Pushed []
Toggle D
Radio L]
Auto Repeat []
String ID HELLO_WORLD i
Text Hello World -= Press anywhere to go to®
Font PROMPT id
Text Align Center R
Normal Text Color SELECTED_TEXT M
Selected Text Color BTN_TEXT i
Disabled Text Color BTN_TEXT 2
Private Text Copy D

Figure 66. Setting Properties of text_button
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29. After Insert and configuration. Window?2 looks like Figure 67.

JGI Azure RTOS GUIX Studio 6.2.1.0 - Hello_World

Project Edit Insert Configure Help
: | ] <] b3 ] v =

h Project View -

2] windowchangertext ~
- window1changer
= Window?2
window?2_text

window2changer

v
Widget Type text_button
Widget Name window2changer
Widget Id ID_WINDOW_2_CHANGER
User Data
Left 31
Top 28
Width 420
Height 212
Border No Border
Transparent
Draw Selected
Enabled

Accepts Focus

Runtime Allocate

Normal fill SELECTED_FILL
Selected fill SELECTED_FILL &2
Disabled fill BTN_LOWER >

Draw Function

Event Function

Pushed |
Toggle ]
Radio I
Auto Repeat I
String ID HELLO_WORLD &2
Text Hello World -= Press anywhere to go to
Font PROMPT &2
Text Align Center ~
Normal Text Color SELECTED_TEXT b
Selected Text Color BTN_TEXT b
Disabled Text Color BTN_TEXT &2
Private Text Copy D

Hello World -> Press anywhere to go to window 1

& Theme: "theme_1"

& Colors

T Fonts

[& Pixelmaps

View Dims Name

=
0 16x16  CHECKBOX_OFF 1KB
16x16  CHECKBOX_ON 1KB

16x16  RADIO_OFF 1KB

@ 16x16  RADIO_ON 1KB

[z Custom

String ID English

BUTTON_DISABLED  Stay in window1

BUTTON_ENABLED  GoTo Window 2

CHECKBOX_TEXT  Press Mel

HELLO_WORLD
INSTRUCT_BUTTON

Hello World -> Press anywhere to go to window 1
Press "Goto window?2" to show the next screen.

INSTRUCT_CHECKBO? Press to activate (blue), "Press me" for more.

WINDOW1 Window1

WINDOW2 Window2

STRING_1 button

STRING_2 prompt

STRING_3 checkbox

[+ Add New String

< >

Figure 67. Window2
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30. Click on drop-down list Pixelmaps, double-click on CHECKBOX_OF” and a new window will pop up.
Uncheck Compress Output then click Save. Do the same for CHECKBOX_ON.

Stay in window1

[ Edit Pixelmap(s)

Source Image Path
] <Project Relative Path>

T Fonts + |

I [&] Pixelmaps

View Dims Name Size
System
O 16x16 CHECKBOX_OFF 1KB
16x16 CHECKBOX_ON 1KB
O 16x16 RADIO_OFF 1KB
@& 16x16 RADIO_ON 1KB
Custom
String ID English s
BUTTON_DISABLED | Stayin window1
[] Press Me! CHECKBOX_TEXT Press Me!
INSTRUCTION_CHECKI Press to activate (blue), "Pre
WINDOW1 Window1

Pixelmap ID: CHECKBOX_OFF

[ ] Specify Output File

Qutput Format

[ ]Raw Format
Compress Qutput I

[ ]Include Alpha Channel

[ ] Dither

Use display default

@ "Compress Output” option will be reset if the compressed data size is bigger than the original.

Cancel

I Save

Figure 68. Set Up Pixelmap
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31. Now you can click on the Project drop down list, Save Project, and Generate All Output Files. You
completed the process of creating and exporting GUIX Hello World into the project.

JG{ Azure RTOS GUIX Studio 6.2.1.0 - Hello_World.gxp

PrajectIEdit Insert Configure Help

New Project Ctrl+N M2 llLda g Q@ s F 06

Open Project Ctrl+0 1 Theme: "theme_ 1"
Save Project As Shift+Ctrl+S i

Close Project T Fonts

Import Project [& Pixelmaps

Recent Projects >

View Dims Name

Generate All Output Files [J System
Generate Resource Files o
16x16 CHECKBOX_OFF 1KB

Generate Specification Files -

Bxit Alt+F4 16x16  CHECKBOX_ON 1KB
Widget Type window 16x16 RADIO_OFF 1KB
Widget Name Window1 @® 16%16 RADIO_ON 1KB
Widget Id ID_WINDOW1
User Data Stay in window1 [ Press Me! [ Custom
Left 0 <[> Strings
Tc 0 j i

e String ID English

Width 480
CHECKBOX_TEXT Press Me!

Height 272

Border No Border INSTRUCT_CHECKBO? Press to activate (blue), "Press me" for more
BUTTON_DISABLED  Stay in window1

Transparent Window1

Draw Selected WINDOWH1 Window1

Enabled HELLO_WORLD Hello World -> Press anywhere to go to window 1

Accepts Focus

~
L
L
WINDOW?2 Window2
JUTTEA PR U BUTTON_ENABLED  GoTo Window 2
Normal fill WINDOW_FILL a2
= INSTRUCT_BUTTON Press "Goto window2" to show the next screen
Selected fill WINDOW_FILL &z F=a
Disabled fill WINDOW FILL o Hello World -> Press anywhere to go to window 1 1+ Add New String
Template O
Visible At Startup O
Draw Function
Event Function window1_screen_event
Wallpaper None &2

Figure 69. Save and Generate Project

32. Make sure the project is active and click to build the project. It may take a long time to finish building an
Azure RTOS/GUIX project on your PC. Project ra8d1_guix_hello_world should be built with no errors
or warnings.

‘l:_ Problems ) console < ‘J Smart Browser D__,' Smart Manua_l_j f} Debug_; = g

| X oo ERE-RE e o
|CDT Build Console [ra8d1_guix hello world]
}Building file: ../ra/fsp/src/bsp/cmsis/Device/RENESAS/Source/system.c ~
'Building file: ../ra/board/ra8dl_ek/board_init.c
Building file: ../ra/board/ra8dl_ek/board_leds.c
iBuilding file: ../ra/board/ra8dl_ek/board_sdram.c
|Building target: ra8dl_guix_hello_world.elf
| arm-none-eabi-objcopy -0 srec "ra8dl_guix_hello_world.elf" "ra8dl_guix_hello_world.srec"
| arm-none-eabi-size --format=berkeley "ra8dl_guix_hello_world.elf"

text data bss dec hex filename
598068 2592 15979968 16580568 fcffde ra8dl_guix_hello_world.elf
i18:35:47 Build Finished. @ errors, @ warnings. (took 4m:48s.264ms) 7
Figure 70. Built the Code
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33. Using the Micro USB cable, connect to J10 on EK-RA8D1 board and the other end to your PC.
Download and run the “ra8d1_guix_hello_world” project.

Stay in window1

Window1

[] Press Me!

Figure 71. Window1 Display

6. Overview of Fully Functional Project

6.1 Overview

In this section, you will import and run the complete “ra8d1_guix_hello_world” project. You can enable or
disable the check box function. The text on the button, which is “Stay in window1” or “Go to Window 2”, will
be updated. Once you press the button, the screen will change from window1 to window?2. Follow the text
message on the screen, you can change from window2 back to window1. Referred to Figure 71.

6.2 Procedural Steps

1. You can try the provided project “ra8d1_guix_hello_world” for the full function application. Use the
Rename & Import Existing C/C++ Project into Workspace feature of the Import menu to do so since
you already had a project with the same in the workspace.

8 Temp1 - ¢ studio
File Edit Source Refactor Navigate Search Project Rer
New Alt+Shift+N >
Open File...
% Open Projects from File System.
Recent Files >
Close Editor Ctrl+W
Close All Editors Ctrl+Shift+W
Save Ctrl+S
Save As.
Save All Ctrl+Shift+S
Revert
Move...
Rename... F2
Refresh 133

Convert Line Delimiters To >
Print...

Export...

Properties
Switch Workspace >
Restart

Exit

a Import

Select

Rename and Import and Existing C/C++ Project into the workspace

Select an import wizard:

‘ type filter text

& import

Rename & Import Project

Select a directory to search for existing Eclipse projects.

Project name: | ra8d1_guix_hello_world

Use default location

v [= General
B Archive File C:\Temp\Temp1\ra8d1_guix_hello_world Browse
&) CMSIS Pack Create Directory for Project
1= Existing Projects into Workspace default
4 File System
[T1 Preferences Import from:
L Projects from Folder or Archive I () Select root directory: Browse
I'@' Rename & Import Existing C/C++ Project into Workspace — = - -
& Rencsas Co 7 Project for CATOKOR/CATERD I (®) Select archive file: C\ra8d_ep\ra8d1_guix_hello_world.zip| Browse I
& Renesas CS+ Project for CC-RX, CC-RL and CC-RH Projects:
" Sample Projects on Renesas Website
B C/C++ ra8d1_guix_hello_world (e2studio/)
(= Install
(> Oomph
Options
[_IKeep build configuration output folders
Cancel

Figure 72.

Import Existing Project
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7. Website and Support

Visit the following URLSs to learn about key elements of the RA family, download components and related
documentation, and get support:

RA Product Information renesas.com/ra

RA Product Support Forum renesas.com/ra/forum

RA Flexible Software Package renesas.com/FSP

Renesas Support renesas.com/support
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external
reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states
of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power

reaches the level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity
of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vix (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in
terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a

system-evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2023 Renesas Electronics Corporation. All rights reserved.
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